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Abstract  

In recent years, sorting of scrap material using various automated techniques has gained a lot 

of focus. One of the multiple steps in the recycling of ferrous & non-ferrous metals is the 

separation of shredded material into different groups. In our project, we propose the concept 

of “Metal & Non-Metal shorting using metal Detector”. The developed automated sorting 

machine can incorporate flexibility and separate pieces of nonmetal object and at the same 

time move object automatically to the bucket as define buy the regulation of the micro-

controller with a capacitive proximity sensor to detect a value rang of object. The result 

obtained shows that metal and nonmetal were sorted in to their respective and correct position 

with a good average time. The projected system involves Arduino Pro Mini, SMPS, Relay. 

sensing element, IR sensor, Proximity sensor, Servo motor, Gear motor, for sensing product 

exactly. This project is useful in automobile industries, steel plants and industry for separation 

of metal and non-metal element in the industry on a large basis. It can also be used for waste 

management so also beneficial for the environment.    
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Chapter 1 Introduction  

1.1 General  
The sorting of materials in garbage industries square measure created manually at this time 

days. There could also be likelihood of errors in sorting. We’ve enforced an answer for 

substitution human by automatic management while not manual power. The project detects the 

objects completely different of various} materials and segregate in 3 different boxes. By usage 

of sensors decreases the errors in sorting and reduces the person power. The projected system 

involves detector, IR sensor, mini limit switch for sensing weight and for sorting purpose linear 

motion electrical actuators square measure used [1]. The motor shaft is connected to the roller 

and also the conveyer belt is placed on the roller these provides sensible tension over the belt. 

The conveyor motors input gets from electrical device. The negative feedback circuit consists 

of ARDUINO board, relay interfacing board, transformer, input interfacing board, DC motors 

[2]. The logic used for sensors for characteristic materials is finished in program by weight and 

inductive means that it's sorted as metal. By weight and reflection it's sorted as glass and if 

solely reflection it's known as plastic. The material sorter has been designed in such the simplest 

way it will fulfill all the wants of the packaging industries wherever merchandise of various 

materials square measure factory-made. It has innumerous application like garbage industries, 

packaging fields. The project is intended in such the simplest way that may manufacture high 

productivity and may type materials while not smashup. By this packaging system becomes 

easier.  

1.2 Objective:  

The objectives of this project are:  

a) To study about metal non-metal product sorting system.  

b) To test the performance of the Metal Non-metal sorting system with Conveyor belt.  



2  

 

Chapter 2 Literature Review  

2.1 Introduction  

In this section topics related to metal nonmetal product sorting systems are included. These 

provide a sampling of problems appropriate for application of a Metal & Nonmetal Product 

sorting System with conveyor belt system. The references are summarized below.  

2.2 Literature   

The concept of automatic sorting arose due to the difficulties faced by the packaging industries. 

The idea of sorting has existed for quite a while after there have been advancements in the 

technology. Shen and Hassan [1] states that an approach for continuous recognition and the 

sorting of objects into their respective and desired location can be implemented as an image of 

color processing that can attract an enormous attention leading to a possible widening scope of 

application in a different field in a modern technology.  

A color-sorting robot is designed and developed using an Arduino Uno micro-controller, SG90 

Tower Pro Servo Motor, TCS3200D color sensor and several other electronic components. The 

system has the potential to sort the objects according to their colors into their relevant colour 

station in a less time. A distinct code for this system is developed. According to Yunardi et al. 

[2], a 3D volume of the packed box is well quantified from the 2D images using the techniques 

of image processing. The 2D image consists of two images captured on the camera with a 

horizontal view and a vertical view. With the parameters, that is, the length, width and the 

height, a multiplication program is used to obtain the result of the volume. Consequently, 

contour-based object detection can be appertained to the automatic sorting system to measure 

the volume of an object in a computer-based vision.  

According to Babita [3], sensors are embedded at several places that detects and senses the 

materials of various sizes that gets sorted at different stations based on their sizes. For sensing, 

the material used is an infrared sensor that is so sensitive. All the process is controlled and 

handled by a PLC. Kulkarni et al. [4] has implemented the sorting of the boxes using a barcode, 
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which is decoded by raspberry pi. This raspberry pi sends a signal to the motor driver to start 

and stop the motor accordingly. Proximity switches are implanted on every cylinder to sense 

the box position, which again sends back the signal to raspberry pi. Relay is used as an interface 

for the motor driver and motor. The relay used is of solid relay type. Raspberry pi uses cameras 

of five megapixels to capture the image, which will then be decoded. The sorting process is 

controlled and handled by Arduino Micro-controller. Automating every sector of industry is an 

important step towards increasing efficiency and reducing human related errors, here we try to 

automate the sorting process by using Controller. The program fed in the Arduino controls the 

entire process [5] .  

2.3 History  

This metal non-metal sorting system is so effective and safe process. It is mainly used in factory 

and industrial area. After it used, we reduce the manpower and time. That’s way we get good 

efficiency. Where very difficult to move company product from here to another location 

perfectly that moment we can easily use this machine. This machine is very easy to use and it 

works very effectively. A relevant picture is added below –  

  

Figure 2.1: Metal Non-metal sorting system with conveyor belt 3d image.  
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Chapter 3 Methodology 

3.1 Process of project:  

• Creating an idea for design and construction of a metal non-metal product sorting 

machine.  

• Collecting the all components/materials for construct the system.  

• Finally, we made this system & checked it finally that working very well.  

3.2 Block Diagram:  

  

Figure 3.1: Block Diagram of metal non-metal product sorting system with conveyor belt  
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3.3 Working Principle  

Our project is designed to separate metal non-metal objects. We are using Arduino Pro Mini for 

controlling our project, which is acting as the main controller here. Also used here sensors, relays, 

valves, motors and air cylinders. Everything comes connected with Arduino. Here the current 

from AC is entering the circuit at 12 volts via SMPS. The Arduino Pro Mini is equipped with two 

sensors. They are proximity sensor and IR Sensor .This proximity sensor and IR sensor are useful 

for sensing the product. The IR sensor senses the object and the proximity sensor detects whether 

it is metal or not. If the conveyor belt rotates, the belt will stop when the object comes in front of 

the IR sensor.We are also use equipment's Servo motor, Gear motor, and Relay.  

In this way we can easily distinguish between metal and nonmetal objects in this machine.  

 

3.4 Complete Project Prototype Image :  

  

Figure 3.2: Project Prototype Image .  
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3.5 Components List:  

1.    Arduino Pro Mini  

2.    SMPS  

3.    Servo Motor 

 4.   DC Gear Motor.  

                                            5.    IR Sensor.  

     6.   Proximity Sensor.  

     7.   Relay Software:  

                                            8.   Arduino IDE  

9. Easy EDA  

3.5.1 Arduino Pro Mini  
The Arduino Pro Mini is a micro-controller board based on the ATmega168. It has 14 digital 

input/output pins (of which 6 can be used as PWM outputs), 6 analog inputs, an on-board 

resonator, a reset button, and holes for mounting pin headers. A six pin header can be connected 

to an FTDI cable to provide USB power and communication to the board.  

Specification  

 Micro-controller ATmega168  

 Operating Voltage: 3.3V or 5V (depending on model)  

 Input Voltage: 3.35 -12 V (3.3V model) or 5 - 12 V (5V model)  

 Digital I/O Pins: 14 (of which 6 provide PWM output)  

 Analog Input Pins: 6  

 DC Current per I/O Pin: 40 mA  

 Flash Memory: 16 KB (of which 2 KB used by boot loader)  

 SRAM: 1 KB  

 EEPROM: 512 bytes  

 Clock Speed: 8 MHz (3.3V model) or 16 MHz (5V model)  



7  

  
Figure 3.3: Arduino Pro Mini  

Pin Out  

Each of the 14 digital pins on the Pro Mini can be used as an input or output, using pin Mode(), 

digital Write(), and digital Read() functions. They operate at 3.3 or 5 volts (depending on the 

model). Each pin can provide or receive a maximum of 40 mA and has an internal pull-up 

resistor (disconnected by default) of 20-50 kOhms. In addition, some pins have specialized 

functions:  

• Serial: 0 (RX) and 1 (TX). Used to receive (RX) and transmit (TX) TTL serial data.  

These pins are connected to the TX-0 and RX-1 pins of the six pin header.  

• External Interrupts: 2 and 3. These pins can be configured to trigger an interrupt on a 

low value, a rising or falling edge, or a change in value. See the attach Interrupt() 

function for details.  

• PWM: 3, 5, 6, 9, 10, and 11. Provide 8-bit PWM output with the analog Write() 

function.  

• SPI: 10 (SS), 11 (MOSI), 12 (MISO), 13 (SCK). These pins support SPI 

communication, which, although provided by the underlying hardware, is not currently 

included in the Arduino language.  

• LED: 13. There is a built-in LED connected to digital pin 13. When the pin is HIGH 

value, the LED is on, when the pin is LOW, it's off.  

The Pro Mini has 6 analog inputs, each of which provide 10 bits of resolution (i.e.  
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1024 different values). Four of them are on the headers on the edge of the board; two 

(inputs 4 and 5) on holes in the interior of the board. The analog inputs measure from 

ground to VCC. Additionally, some pins have specialized functionality:  

There is another pin on the board:  

• Reset. Bring this line LOW to reset the micro controller. Typically used to add a reset 

button to shields which block the one on the board.  

See also the mapping between Arduino pins and ATmega168 ports.  

 

The high-performance Microchip Pico Power 8-bit AVR RISC-based micro controller 

combines 32KB ISP flash memory with read-while-write capabilities, 1024B EEPROM, 2KB 

SRAM, 23 general purpose I/O lines, 32 general purpose working registers, three flexible 

timer/counters with compare modes, internal and external interrupts, serial programmable 

USART, a byte-oriented 2-wire serial interface, SPI serial port, a 6-channel 10-bit A/D 

converter (8-channels in TQFP and QFN/MLF packages), programmable watchdog timer with 

internal oscillator, and five software selectable power saving modes. The device operates 

between 1.8-5.5 volts. By executing powerful instructions in a single clock cycle, the device 

achieves throughputs approaching 1 MIPS per MHz, balancing power consumption and 

processing speed.  

Micro controller IC ATmega328p  

  

Figure 3.4: Micro controller IC AT Mega 328p  

3.5.2 Switch Mode Power Supply (SMPS):  

A switched-mode power supply (switching-mode power supply, switch-mode power supply, 

switched power supply, SMPS, or switcher) is an electronic power supply that incorporates a 

switching regulator to convert electrical power efficiently. Like other power supplies, an SMPS 
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transfers power from a DC or AC source (often mains power) to DC loads, such as a personal 

computer, while converting voltage and current characteristics. Unlike a linear power supply, 

the pass transistor of a switching-mode supply continually switches between low-dissipation, 

full-on and full-off states, and spends very little time in the high dissipation transitions, which 

minimizes wasted energy. A hypothetical ideal switched-mode power supply dissipates no 

power. Voltage regulation is achieved by varying the ratio of onto-off time (also known as duty 

cycles). In contrast, a linear power supply regulates the output voltage by continually 

dissipating power in the pass transistor. This higher power conversion efficiency is an important 

advantage of a switched-mode power supply. Switched mode power supplies may also be 

substantially smaller and lighter than a linear supply due to the smaller transformer size and 

weight.  

  

Fig 3.5: SMPS  

Switching regulators are used as replacements for linear regulators when higher efficiency, 

smaller size or lighter weight are required. They are, however, more complicated; their 

switching currents can cause electrical noise problems if not carefully suppressed, and simple 

designs may have a poor power factor.  

12V 5A Industrial SMPS Power Supply – 60W – DC Metal Power Supply – Good Quality – 

Non Waterproof with Aluminium casing.  

• Input Voltage: AC 100 – 264V 50 / 60Hz  

• Output Voltage: 12V DC, 0-5A  

• Output voltage: Adjustment Range: ±20%  

• Protections: Overload / Over Voltage / Short Circuit  
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• Auto-Recovery After Protection  

• Universal AC input / Full range  

• 100% Full Load Burn-in Test  

• Cooling by Free Air Convection  

• High Quality and High Performance  

• LED power supply with a metal body for hidden installation for LED lighting  Design 

with Built-in EMI Filter, improve signal precision.  

• Certifications: CE & RoHs  No Minimum Load.  

• Compact Size Light Weight.  

• High Efficiency, Reliabiltiy & low energy consumption  

• Category – Switch Mode Power Adaptor (SMPS)  

Switched-mode power supplies are classified according to the type of input and output voltages.  

The four major categories are:  

• AC to DC  

• DC to DC  

• DC to AC  

• AC to AC  

A basic isolated AC to DC switched-mode power supply consists of:  

• Input rectifier and filter  

• Inverter consisting of switching devices such as MOSFETs  

• Transformer  

• Output rectifier and filter  

• Feedback and control circuit  

The input DC supply from a rectifier or battery is fed to the inverter where it is turned on and 

off at high frequencies of between 20 KHz and 200 KHz by the switching MOSFET or power 

transistors. The high-frequency voltage pulses from the inverter are fed to the transformer 

primary winding, and the secondary AC output is rectified and smoothed to produce the 

required DC voltages. A feedback circuit monitors the output voltage and instructs the control 

circuit to adjust the duty cycle to maintain the output at the desired level.  
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Fig 3.6: SMPS Circuit Design  

Basic working concept of an SMPS : 
 
A switching regulator does the regulation in the SMPS. A series switching element turns the 

current supply to a smoothing capacitor on and off. The voltage on the capacitor controls the 

time the series element is turned. The continuous switching of the capacitor maintains the 

voltage at the required level.  

Design basics  

AC power first passes through fuses and a line filter. Then it is rectified by a full-wave bridge 

rectifier. The rectified voltage is next applied to the power factor correction (PFC) preregulator 

followed by the downstream DC-DC converter(s). Most computers and small appliances use 

the International Electro technical Commission (IEC) style input connector. As for output 

connectors and pin outs, except for some industries, such as PC and compact PCI, in general, 

they are not standardized and are left up o the manufacturer.  

There are different circuit configurations known as topologies, each having unique 

characteristics, advantages and modes of operation, which determines how the input power is 

transferred to the output. Most of the commonly used topologies such as flyback, push-pull, 

half bridge and full bridge, consist of a transformer to provide isolation, voltage scaling, and 

multiple output voltages. The non-isolated configurations do not have a transformer and the 

power conversion is provided by the inductive energy transfer.  



12  

Advantages of switched-mode power supplies:  

• Higher efficiency of 68% to 90%  

• Regulated and reliable outputs regardless of variations in input supply voltage  

• Small size and lighter  

• Flexible technology   High power density  

Disadvantages:  

• Generates electromagnetic interference  

• Complex circuit design  

• Expensive compared to linear supplies  

Switched-mode power supplies are used to power a wide variety of equipment such as 

computers, sensitive electronics, battery-operated devices and other equipment requiring high 

efficiency.  

Switch Mode Power Supply  

  

Fig 3.8: Power Supply Connection  

Linear voltage IC regulators have been the basis of power supply designs for many years as 

they are very good at supplying a continuous fixed voltage output.  
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Linear voltage regulators are generally much more efficient and easier to use than equivalent 

voltage regulator circuits made from discrete components such a zener diode and a resistor, or 

transistors and even op-amps.  

The most popular linear and fixed output voltage regulator types are by far the 78… positive 

output voltage series, and the 79… negative output voltage series. These two types of 

complementary voltage regulators produce a precise and stable voltage output ranging from 

about 5 volts up to about 24 volts for use in many electronic circuits.  

There is a wide range of these three-terminal fixed voltage regulators available each with its 

own built-in voltage regulation and current limiting circuits. This allows us to create a whole 

host of different power supply rails and outputs, either single or dual supply, suitable for most 

electronic circuits and applications. There are even variable voltage linear regulators available 

as well providing an output voltage which is continually variable from just above zero to a few 

volts below its maximum voltage output.  

Most d.c. power supplies comprise of a large and heavy step-down mains transformer, diode 

rectification, either full-wave or half-wave, a filter circuit to remove any ripple content from 

the rectified d.c. producing a suitably smooth d.c. voltage, and some form of voltage regulator 

or stabilizer circuit, either linear or switching to ensure the correct regulation of the power 

supplies output voltage under varying load conditions. Then a typical d.c. power supply would 

look something like this.These typical power supply designs contain a large mains transformer 

(which also provides isolation between the input and output) and a dissipative series regulator 

circuit. The regulator circuit could consist of a single zener diode or a three-terminal linear 

series regulator to produce the required output voltage. The advantage of a linear regulator is 

that the power supply circuit only needs an input capacitor, output capacitor and some feedback 

resistors to set the output voltage.  

3.5.3 IR Sensor:  

An infrared sensor is an electronics device that emits certain features around it and / or detects 

infrared radiation. Infrared sensors are capable of measuring the heat emitted by an object and 

detecting motion. In this project we will control the fan and light automatically through the 

closed loop system so the IR sensor for the system is definitely needed as a response. Here the 

fan will turn on and the light will turn on when the IR sensor detects an object and the fan and 

light will switch off automatically when an object leaves the house.  
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Figure 3.8: IR Sensor  

  

Figure 3.9: IR sensor reflection System.  

Principles of operation:  

Sensor works with sense. When an object intersects the sensor light then the sensor detects 

something .Some infrared ray is deflected from the object and scene the length of this distance. 

In this sensor we can make a fixed length light and detect our exact object. If some object comes 

in front of this sensor then the sensor detects it and sends a signal in LED.  
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Figure 3.10: IR sensor Detection System.  

3.5.4 Relay  

A relay is an electrically operated switch. Many relays use an electromagnet to mechanically 

operate a switch, but other operating principles are also used, such as solid-state relays. Relays 

are used where it is necessary to control a circuit by a separate low-power signal, or where 

several circuits must be controlled by one signal. The first relays were used in long distance 

telegraph circuits as amplifiers: they repeated the signal coming in from one circuit and 

retransmitted it on another circuit. Relays were used extensively in telephone exchanges and 

early computers to perform logical operations.  

    
Figure 3.11: Relay  
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A type of relay that can handle the high power required to directly control an electric motor or 

other loads is called a contactor. Solid-state relays control power circuits with no moving parts, 

instead using a semiconductor device to perform switching. Relays with calibrated operating 

characteristics and sometimes multiple operating coils are used to protect electrical circuits 

from overload or faults; in modern electric power systems these functions are performed by 

digital instruments still called "protective relays".  

Magnetic latching relays require one pulse of coil power to move their contacts in one direction, 

and another, redirected pulse to move them back. Repeated pulses from the same input have no 

effect. Magnetic latching relays are useful in applications where interrupted power should not 

be able to transition the contacts.  

Magnetic latching relays can have either single or dual coils. On a single coil device, the relay 

will operate in one direction when power is applied with one polarity, and will reset when the 

polarity is reversed. On a dual coil device, when polarized voltage is applied to the reset coil 

the contacts will transition. AC controlled magnetic latch relays have single coils that employ 

steering diodes to differentiate between operate and reset commands.  

The circuit above is called a low-side switch, because the switch – our transistor – is on the low 

(ground) side of the circuit. Alternatively, we can use a PNP transistor to create a highside switch: 

Similar to the NPN circuit, the base is our input, and the emitter is tied to a constant voltage.  

A relay is an electrically operated switch of mains voltage. It means that it can be turned on or 

off, letting the current go through or not. Controlling a relay with the Arduino is as simple  

  

Figure 3.12: Relay Module.  
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as controlling an output such as an LED. The relay module is the one in the figure below.  

This module has two channels (those blue cubes). There are other varieties with one, four and 

eight channels.  

Mains voltage connections: In relation to mains voltage, relays have 3 possible connections. 
 

  COM: common pin  

NO (Normally Open):there is no contact between the common pin and the normally open pin. 

So, when you trigger the relay, it connects to the COM pin and supply is provided to a load. 

 

NC (Normally Closed): there is contact between the common pin and the normally closed 

pin.There is always connection between the COM and NC pins, even when the relay is turned 

off. When you trigger the relay, the circuit is opened and there is no supply provided to a load.  

If you want to control a lamp for example, it is better to use a normally-open circuit, because 

we just want to light up the lamp occasionally.  

 

 

Pin wiring:  

The connections between the relay module and the Arduino are really simple:  
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Figure 3.13: Main Voltage Connection  

 GND: goes to ground  

IN1: controls the first relay (it will be connected to an Arduino digital pin)  

IN2: controls the second relay (it should be connected to an Arduino digital pin if you are using 

this second relay. Otherwise, you don’t need to connect it) VCC: goes to 5V  

3.5.5 DC Gear Motor 

Description:  

A DC motor is any motor within a class of electrical machines whereby direct current electrical 

power is converted into mechanical power. ... A 12v DC motor is small and inexpensive, yet 

powerful enough to be used for many applications.  

Specification:  

• Voltage: 12V DC  

• Gear ratio: 1/31  

• No-load speed: 200RPM  

• Rated Speed: 140RPM  

• Rated torque: 10kg.cm  

• Rated current: 2.5Amp  

• Length of Motor(including spindle): 106mm/4.17″  

• Diameter: 37mm/1.45″  

• Shaft length: 21mm/0.82″  

• Shaft diameter: 6mm/0.24″  
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                                                            Fig: 3.14: DC Gear Motor  

3.5.6 Proximity Sensor:  

A proximity sensor is a sensor able to detect the presence of nearby objects without any 

physical contact.  

A proximity sensor often emits an electromagnetic field or a beam of electromagnetic radiation 

(infrared, for instance), and looks for changes in the field or return signal. The object being 

sensed is often referred to as the proximity sensor's target. Different proximity sensor targets 

demand different sensors. For example, a capacitive proximity sensor or photoelectric sensor 

might be suitable for a plastic target; an inductive proximity sensor always requires a metal 

target.  

Proximity sensors can have a high reliability and long functional life because of the absence of 

mechanical parts and lack of physical contact between the sensor and the sensed object.  

Proximity sensors are also used in machine vibration monitoring to measure the variation in 

distance between a shaft and its support bearing. This is common in large steam turbines, 

compressors, and motors that use sleeve-type bearings.  
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Types of Proximity Sensor  

• Inductive Proximity Sensor.  

• Optical Proximity Sensor.  

• Capacitive Proximity Sensor.  

• Magnetic Proximity Sensor.  

• Ultrasonic proximity Sensor.  

Proximity sensors are suitable for damp conditions and wide temperature range usage, unlike 

your traditional optical detection. Proximity sensors are also applicable in phones as well, be it 

your Android or IOS devices. It consists of simple IR technology that switches on and off 

display accordingly to your usage. Proximity sensors are used in phones, recycling plants, self 

driving cars, anti-aircraft systems, and assembly lines. There are many types of proximity 

sensors, and they each sense targets in distinct ways.  

• Model: LJ12A3-4-Z/BY  

• Wire Type - Cylindrical DC 3 Wire Type  

• Switch Appearance Type - Cylinder Type  

• Theory - Inductive Sensor  

• Output Type - PNP NO(Normal Open)  

• Diameter of Head - 12mm   
• Detecting Distance - 4mm  

• Supply Voltage - DC 6-36V  

• Current Output - 300mA  

• Response Frequency - 0.5KHz  

• Detect Object - Iron  

• Operating Temperature -25°C to +55°C (Non-freezing Condition)  

• Size 6.2 x 2cm/2.4'' x 0.8'' (L*Max. Dia)  

• Cable Length 110cm/43.3"  

• External Material Plastic, Alloy  

• Net Weight 46g  
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Fig 3.15: Proximity Sensor  

3.5.7 Servo Motor  

A servomotor is a closed-loop servomechanism that uses position feedback to control its motion 

and final position. The input to its control is a signal (either analogue or digital) representing 

the position commanded for the output shaft. The motor is paired with some type of position 

encoder to provide position and speed feedback. In the simplest case, only the position is 

measured. The measured position of the output is compared to the command position, the 

external input to the controller. If the output position differs from that required, an error signal 

is generated which then causes the motor to rotate in either direction, as needed to bring the 

output shaft to the appropriate position. As the positions approach, the error signal reduces to 

zero and the motor stops.  

The very simplest servomotors use position-only sensing via a potentiometer and bang-bang 

control of their motor; the motor always rotates at full speed (or is stopped). This type of 

servomotor is not widely used in industrial motion control, but it forms the basis of the simple 

and cheap servos used for radio-controlled models. More sophisticated servomotors use optical 

rotary encoders to measure the speed of the output shaft and a variable-speed drive to control 

the motor speed. Both of these enhancements, usually in combination with a PID control 
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algorithm, allow the servomotor to be brought to its commanded position more quickly and 

more precisely, with less overshooting.  

  

Figure 3.17: Servo Motor  

3.5.8 Arduino IDE  

The digital micro-controller unit named as Arduino Nano can be programmed with the Arduino 

software IDE. There is no any requirement for installing other software rather than Arduino. 

Firstly, Select "Arduino Nano from the Tools, Board menu (according to the microcontroller 

on our board). The IC used named as ATmega328 on the Arduino Nano comes pre burned with 

a boot loader that allows us to upload new code to it without the use of an external hardware 

programmer.  

Communication is using the original STK500 protocol (reference, C header files). We can also 

bypass the boot loader and programs the micro-controller through the ICSP (In Circuit Serial 

Programming) header. The ATmega16U2 (or 8U2 in the rev1 and rev2 boards) firmware source 

code is available. The ATmega16U2/8U2 is loaded with a DFU boot loader, which can be 

activated by:  

On Rev1 boards: connecting the solder jumper on the back of the board (near the map of Italy) 

and then resetting the 8U2. On Rev2 or later boards: there is a resistor that pulling the 

8U2/16U2 HWB line to ground, making it easier to put into DFU mode.  
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The Arduino Nano is one of the latest digital micro-controller units and has a number of 

facilities for communicating with a computer, another Arduino, or other micro-controllers. The 

ATmega328 provides UART TTL at (5V) with serial communication, which is available on 

digital pins 0 -(RX) for receive the data and pin no.1 (TX) for transmit the data. An 

ATmega16U2 on the board channels this serial communication over USB and appears as a 

virtual com port to software on the computer. The '16U2 firmware uses the standard USB COM 

drivers, and no external driver is needed. However, on Windows, an .in file is required. The 

Arduino software includes a serial monitor which allows simple textual data to be sent to and 

from the Arduino board.  

The RX and TX LEDs on the board will flash when data is being transmitted via the 

USBtoserial chip and USB connection to the computer (but not for serial Communication on 

pins 0 and 1). A Software Serial library allows for serial communication on any of the Nano's 

digital pins. The ATmega328 also supports I2C (TWI) and SPI communication. The Arduino 

software includes a Wire library to simplify use of the I2C bus. Arduino programs are written 

in C or C++ and the program code written for Arduino is called sketch. The Arduino IDE uses 

the GNU tool chain and AVR Lab to compile programs, and for uploading the programs it uses 

argued. As the Arduino platform uses Atmel micro-controllers, Atmel's development 

environment, AVR Studio or the newer Atmel Studio, may also be used to develop software 

for the Arduino.  

 

Writing Sketches  

Programs written using Arduino Software (IDE) are called sketches. These sketches are written 

in the text editor and are saved with the file extension. The editor has features for 

cutting/pasting and for searching/replacing text. The message area gives feedback while saving 

and exporting and also displays errors. The console displays text output by the Arduino 

Software (IDE), including complete error messages and other information. The bottom 

righthand corner of the window displays the configured board and serial port. The toolbar 

buttons allow you to verify and upload programs, create, open, and save sketches, and open the 

serial monitor.  
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Sketchbook  

The Arduino Software (IDE) uses the concept of a sketchbook: a standard place to store your 

programs (or sketches). The sketches in your sketchbook can be opened from the File > 

Sketchbook menu or from the Open button on the toolbar. The first time you run the Arduino 

software, it will automatically create a directory for your sketchbook. You can view or change 

the location of the sketchbook location from with the Preferences dialog. Beginning with 

version 1.0, files are saved with a .ino file extension. Previous versions use the .pde extension. 

You may still open .pde named files in version 1.0 and later, the software will automatically 

rename the extension to .ino.  

Tabs, Multiple Files, and Compilation  

Allows you to manage sketches with more than one file (each of which appears in its own tab). 

These can be normal Arduino code files (no visible extension), C files (.c extension), C++ files 

(.cpp), or header files (.h).  

Uploading  

Before uploading your sketch, you need to select the correct items from the Tools > Board and 

Tools > Port menus. The boards are described below. On the Mac, the serial port is probably 

something like /dev/tty.usbmodem241 (for an Uno or Mega2560 or Leonardo) or  

/dev/tty.usbserial-1B1 (for a Duemilanove or earlier USB board), or 

/dev/tty.USA19QW1b1P1.1 (for a serial board connected with a Keyspan USB-to-Serial 

adapter). On Windows, it's probably COM1 or COM2 (for a serial board) or COM4, COM5, 

COM7, or higher (for a USB board) - to find out, you look for USB serial device in the ports 

section of the Windows Device Manager. On Linux, it should be /dev/ttyACMx , /dev/ttyUSBx 

or similar. Once you've selected the correct serial port and board, press the upload button in the 

toolbar or select the Upload item from the Sketch menu. Current Arduino boards will reset 

automatically and begin the upload. With older boards (preDiecimila) that lack auto-reset, 

you'll need to press the reset button on the board just before starting the upload. On most boards, 

you'll see the RX and TX LEDs blink as the sketch is uploaded. The Arduino Software (IDE) 

will display a message when the upload is complete, or show an error.  
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When you upload a sketch, you're using the Arduino boot-loader, a small program that has been 

loaded on to the micro-controller on your board. It allows you to upload code without using 

any additional hardware. The boot-loader is active for a few seconds when the board resets; 

then it starts whichever sketch was most recently uploaded to the micro-controller. The boot-

loader will blink the on-board (pin 13) LED when it starts (i.e. when the board resets).  

Libraries  

Libraries provide extra functionality for use in sketches, e.g. working with hardware or 

manipulating data. To use a library in a sketch, select it from the Sketch > Import Library menu. 

This will insert one or more #include statements at the top of the sketch and compile the library 

with your sketch. Because libraries are uploaded to the board with your sketch, they increase 

the amount of space it takes up. If a sketch no longer needs a library, simply delete its #include 

statements from the top of your code.  

There is a list of libraries in the reference. Some libraries are included with the Arduino 

software. Others can be downloaded from a variety of sources or through the Library Manager. 

Starting with version 1.0.5 of the IDE, you do can import a library from a zip file and use it in 

an open sketch. See these instructions for installing a third-party library.  

Third-Party Hardware  

Support for third-party hardware can be added to the hardware directory of your sketchbook 

directory. Platforms installed there may include board definitions (which appear in the board 

menu), core libraries, bootloaders, and programmer definitions. To install, create the hardware 

directory, then unzip the third-party platform into its own sub-directory. (Don't use "arduino" 

as the sub-directory name or you'll override the built-in Arduino platform.) To uninstall, simply 

delete its directory.  

For details on creating packages for third-party hardware, see the Arduino IDE 1.5 3rd party 

Hardware specification.  

Serial Monitor  

This displays serial sent from the Arduino or Genuino board over USB or serial connector. To 

send data to the board, enter text and click on the "send" button or press enter. Choose the baud 
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rate from the drop-down menu that matches the rate passed to Serial.begin in your sketch. Note 

that on Windows, Mac or Linux the board will reset (it will rerun your sketch) when you 

connect with the serial monitor. Please note that the Serial Monitor does not process control 

characters; if your sketch needs a complete management of the serial communication with 

control characters, you can use an external terminal program and connect it to the COM port 

assigned to your Arduino board.  

3.5.9 EasyEDA Software  
EasyEDA is a web-based EDA tool suite that enables hardware engineers to design, simulate, 

share - publicly and privately - and discuss schematics, simulations and printed circuit boards. 

Other features include the creation of a bill of materials, Gerber files and pick and place files 

and documentary outputs in PDF, PNG and SVG formats.EasyEDA allows the creation and 

editing of schematic diagrams, SPICE simulation of mixed analogue and digital circuits and 

the creation and editing of printed circuit board layouts and, optionally, the manufacture of 

printed circuit boards.  

Subscription-free membership is offered for public plus a limited number of private projects. 

The number of private projects can be increased by contributing high quality public projects, 

schematic symbols, and PCB footprints and/or by paying a monthly subscription.Registered 

users can download Gerber files from the tool free of charge; but for a fee, EasyEDA offers a 

PCB fabrication service. This service is also able to accept Gerber file inputs from third party 

tools.  

  

Figure 3.18: EasyEDA Software Interface  



27  

Chapter 4 Result, Discussion And Analysis 

 

 

4.1 Result  

We have been able to build our system by following all the objects and methodologies. At first 

we have set up the all components well for our system. Here the proximity sensor and IR sensor 

are used to detect metal and non-metal objects. The efficiency of this project is very good. It is 

capable of working for a long time. We are satisfied its performance.  

 4.2 Discussion  

This kind of project already many of student study before, but they control it PLC system. We 

control with a gear motor. When we made this project then we face some of problem. We did not 

run it smoothly. After hard work and team work we did it .   

                                       

 4.3 Equipment Cost Analysis 

 
                              In the below table we have summarized our project expenditure. 
 

SL NO Components Name Rating Quantity Price(Tk) 

1 Arduino pro mini ATmega328 1 680 

2 SMPS 5V, 12V 1 490 

3 Servo motor SG90 2 300 

4 DC Gear motor 12 v 1 1000 

5 IR Sensor LM393 1 100 

6 Proximity sensor LJ12A3-4-Z/BXNPN 1 350 

7 Relay 1 channel 1 350 

8 Timing pully GT2 1 270 

9 Others   2000 

   Total 5540/= 
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Chapter 5 Conclusion  
.  

5.1 Advantage  

• Good accuracy to find metal and non-metal object.  

• Time saving machine for industrial work.  

• Very effectively work for product peak and place.  

• Reduce energy waste.  

• No Oil consumption.  

• Less skill technicians is sufficient to operate.  

• Installation is simplified very much.  

• Less time and more profit.  

• Simple construction  

• Reduced weight of the system.  

• Ease of operation.  

5.2 Application  

The project has a major application in the  

• It can be used for Industrial work.  

• It can be used in factories for peak and place.  

• It can be used in pharmacy.  

• It can be used for metal no-metal separator.  

5.3 Limitation  

It is a demo project so we found some limitation. In future we will work for reduce this kind of 

limitation. These limitations are –  

• It is a demo project so its accuracy is 85%.  

• This compressor have no extra air chamber.  

• Our project may delay in work .  
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5.4 Future Scope  

The model can be improved by making some changes in the program and components. Some 

suggestions are given below-  

• We can add a monitoring based control to automate control.  

• We will increase its working accuracy level.  

• We will add an air reserve tank.  

5.5 Conclusion:  

The main objective of this project was to develop an object sorting system based on certain 

specifications. This was successfully implemented. We consider this project as a journey where 

we acquired knowledge and also gained some insights into the subject which we have shared in 

this report. Arduino was used to control the various operations. More features can be added to this 

system as follows: depending on the size, shape and weight of the objects, sorting operations can 

be implemented. Sorting operation can be improvised using a piston arrangement.  
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